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Preface 
This preface is an introduction to the Exigen Universal Process Link Installation and Configuration 
Guide. 

The following topics are included in this preface: 

• Audience 
• How to Use This Guide 
• Related Information 
• Typographic Conventions 

Audience 
This guide is intended mainly for system administrators who install and configure Exigen Universal 
Process Link. 

To effectively use this guide, knowledge of the following software is required: 

• Exigen Workflow 
• Genesys CIM Platform 

How to Use This Guide 
The following is an overview of the guide: 

• Chapter 1: Introducing Exigen Universal Process Link describes Exigen Universal Process Link. 
• Chapter 2: Managing Exigen Universal Process Link Installation describes how to install, upgrade, 

or remove Exigen Universal Process Link. 
• Chapter 3: Configuring Exigen Universal Process Link describes how to set up Exigen Universal 

Process Link components. 
• Chapter 4: Best Practices and Recommendations provides recommendations to solution 

implementation teams for using workflow statistics. 
• Appendix A: Workflow Statistics Architecture describes the workflow statistics architecture. 
• Appendix B: Internal Configuration of Workflow Statistics describes workflow statistics internal 

configuration. 

Related Information 
The following is a list of sources containing information related to Exigen Universal Process Link: 

• Exigen Workflow documentation 
• Genesys CIM Platform documentation 
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Typographic Conventions 
The following styles and conventions are used in this guide:  

Typographic styles and conventions 
Convention Description 
Bold • Represents user interface items such as check boxes, command buttons, dialog 

boxes, drop-down list values, field names, menu commands, menus, option 
buttons, perspectives, tabs, tooltip labels, tree elements, views, and windows. 

• Represents keys, such as F9 or CTRL+A. 
• Represents a term the first time it is defined. 

Courier Represents file and directory names, code, system messages, and command-line 
commands.  

Courier Bold Represents emphasized text in code.  
Select File > Save 
As 

Represents a command to perform, such as opening the File menu and selecting Save 
As.  

Italic • Represents any information to be entered in a field.  
• Represents documentation titles.  

<  > Represents placeholder values to be substituted with user specific values.  
Hyperlink Represents a hyperlink. Clicking on this field takes you to the identified place in 

this guide. 
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Chapter 1: Introducing Exigen Universal 
Process Link 
This section introduces Exigen Universal Process Link and describes its components and basic 
functionality. 

The following topics are described in this section: 

• What is Exigen Universal Process Link? 
• Exigen Universal Process Link Architecture 
• Understanding the Interaction Flow 

What is Exigen Universal Process Link? 
Exigen Universal Process Link is a solution containing a set of configuration components that 
integrate Exigen Workflow and Genesys CIM Platform systems in a call center environment to provide 
blended delivery of interactions to agents according to call center business rules. Exigen Universal 
Process Link interacts with Genesys CIM Platform using Open Media interfaces. 

The following table describes the systems integrated using Exigen Universal Process Link: 

Exigen Universal Process Link integration solutions 
Solution Description 
Exigen Workflow Customizable workflow management and document imaging system. Although 

Exigen Workflow does not include decision-making procedures for real-time routing, 
its document management for non-real time processing is flexible and meets broad 
business needs. 

Genesys CIM Platform  Real-time interaction management system.  

The following diagram illustrates how Exigen Workflow, Exigen Universal Process Link, and Genesys 
CIM Platform interact to provide work item and call processing and deliver interactions to agents: 
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Figure 1: Exigen Workflow, Exigen Universal Process Link, and Genesys CIM Platform functional flow 

The upper part of the diagram shows a typical Genesys call processing flow. The lower part of the 
diagram illustrates an example of Exigen Workflow work item processing flow. The middle of the 
diagram shows a link between Genesys CIM Platform and Exigen Workflow. Agents receive calls or 
work items as input and perform tasks initiated by physical or virtual calls. To perform business tasks 
more efficiently, agents have a unified desktop. For example, agents use the same desktop for 
consulting a customer via the phone and processing customer's documents captured by Exigen 
Workflow. 

Exigen Universal Process Link Architecture 
This section describes the main components involved in the Exigen Universal Process Link 
architecture. 

The following diagram represents Exigen Universal Process Link architecture with Exigen Universal 
Process Link components colored in blue: 
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Figure 2: Exigen Universal Process Link architecture 

The following table describes components involved in Exigen Universal Process Link architecture: 

Exigen Universal Process Link components 
System Component Description 
Exigen Workflow Exigen Workflow 

database 
Storage place for work items and other workflow data. It is 
also used to store configuration parameters, such as workflow 
maps, agent credentials, system settings, and other 
parameters. 
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Exigen Universal Process Link components 
System Component Description 
 Automatic Queue 

Server 
Workflow object that automatically processes work items in 
background mode without user interaction. Automatic Queue 
Server can be mapped to multiple custom scripts that 
implement customer-specific business logic. In Exigen 
Universal Process Link, Automatic Queue Server is used to 
select work items from the Exigen Workflow database to be 
delivered to Genesys Interaction Server through the 
Interaction Submitter handler and Exigen Universal Process 
Link (UPL) Interaction Layer. 

Genesys 
configuration 
database 

Storage place for the following data: 
• call center configuration required by Genesys components 
• primary agent credentials 

DB Server Component that provides standard access to the Genesys 
database. 

Configuration 
Server 

Component that performs the following: 
• provides access to configuration data 
• ensures configuration data integrity 
• casts real-time notifications when the configuration is 

modified 
Configuration 
Manager 

Application used to edit configuration data managed by 
Configuration Server. 

Interaction Server Component that performs the following: 
• monitors all call center interactions in near real-time 
• provides control over interactions 
• casts notifications about interaction progress 

Universal Routing 
Server (URS) 

Component that selects the most appropriate target to receive 
call center interactions. 
URS is triggered by notifications received from Interaction 
Server and uses the Interaction Server application 
programming interface (API) to indicate to which target 
interactions must be delivered. To select the target for 
submitted interactions, URS evaluates target selection 
algorithms. 

Interactive Routing 
Designer (IRD) 

Application used to build target selection algorithms or 
strategies. 

Message Server Communication channel between IRD and URS controlling the 
delivery of messages between the applications to provide IRD 
users with a real-time view of interaction routing status. 
In general, Message Server provides centralized processing 
and storage of all application maintenance events. Therefore, 
it can be used by any Genesys server component. 

Genesys CIM Platform 

Stat Server Component that on request supplies statistical information 
about customer interaction networks to client applications 
such as URS and CCPulse+. 
For example, URS can use numerical statistics provided by 
Stat Server as routing criteria. 
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Exigen Universal Process Link components 
System Component Description 

Interaction 
Submitter 

Automatic Queue Server handler that submits Exigen 
Workflow work items as interactions to Genesys Interaction 
Server through UPL Interaction Layer and transforms work 
item properties to interaction properties. 
For information on configuring Interaction Submitter, see 
Configuring the Interaction Submitter Job. 

Interaction 
Submitter Filter 

Automatic Queue Server filter handler that selects work items 
that are due for submission to Genesys CIM Platform. 
Automatic Queue Server invokes Interaction Submitter Filter 
to retrieve additional criteria for work item retrieval from the 
Exigen Workflow database. 
For information on configuring Interaction Submitter Filter, see 
Configuring the Interaction Submitter Job. 

Exigen Universal 
Process Link 

UPL Interaction 
Layer 

Windows service application that connects to Genesys CIM 
Platform and submits interactions using the Genesys Open 
Media interaction layer API.  
UPL Interaction Layer works as a bridge between Interaction 
Submitter and Genesys CIM Platform. 
For information on configuring UPL Interaction Layer, see 
Configuring UPL Interaction Layer. 

Understanding the Interaction Flow 
This section describes a typical interaction flow to show how system components work together to 
distribute and deliver work items. 

The following is a typical sequence of steps that are performed in the interaction flow: 

1. Exigen Workflow work items are delivered to a designated mailbox that is a juncture of a workflow 
node and a workflow user. Work items remain in the mailbox until they are either dispatched to 
Genesys CIM Platform by Exigen Universal Process Link or removed from the mailbox by another 
process. 

2. The dedicated Automatic Queue Server job monitors the mailbox using Integration Submitter Filter. 
Integration Submitter Filter is responsible for selecting work items due for submission, thus enabling 
delayed submission of work items. 

3. Selected work items are dispatched for processing to Integration Submitter. Integration Submitter is 
responsible for actions required to be performed to submit an interaction. These actions include the 
following: 
• changing the work item state 
• transmitting properties from work items to interactions 
• submitting interactions to UPL Interaction Layer 

4. UPL Interaction Layer submits interactions to the Genesys Interaction Server using the Genesys 
Open Media API. After submission, interactions remain in the Interaction Server database.  
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5. URS executes routing strategies and, in conjunction with Interaction Server, delivers interactions to 
call center agents for processing. Life cycle durations of interactions submitted to Genesys CIM 
Platform depend on strategies used by the business. 
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Chapter 2: Managing Exigen Universal 
Process Link Installation 
This section provides Exigen Universal Process Link system requirements and describes how to install, 
upgrade, and remove Exigen Universal Process Link. 

The following topics are described in this section: 

• System Requirements 
• Installing Exigen Universal Process Link 
• Upgrading Exigen Universal Process Link 
• Removing Exigen Universal Process Link 

System Requirements 
The following table lists Exigen Universal Process Link system requirements: 

Exigen Universal Process Link system requirements 
Component Description 

Operating system Windows Server 2003 Service Pack 1 or higher 

Processor Pentium IV 1.5 GHz or higher 

Database server One of the following database brands is required: 
• SQL Server 2000 
• Oracle 10.1 

Software The following software is required: 
• Exigen Workflow 5.6.12 
• Genesys CIM Platform 7.2 
• MDAC 2.8 or higher 
• .NET 2.0  

RAM 1 GB 

Free disk space 500 MB 

Installing Exigen Universal Process Link 
To install Exigen Universal Process Link, proceed as follows: 

1. If Automatic Queue Server is already installed on the workstation and its service is running, stop the 
Automatic Queue Server service to allow registering Exigen Universal Process Link handlers. 

2. In the Exigen Universal Process Link installation package, launch the Setup.exe file located in the 
Windows directory. 

The Exigen Installer Setup window appears. 
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Figure 3: Exigen Installer startup window 

3. Wait while Exigen Installer verifies the list of installed applications. 

The Exigen Installer Setup window is updated with product information. 
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Figure 4: Exigen Universal Process Link welcome window 

4. Click Next. 

The User Information window appears. 
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Figure 5: Specifying user information 

5. Enter the user and organization name and click Next. 

The Select Installation Type window appears. 
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Figure 6: Selecting the installation type 

6. Select Custom and click Next. 

The Setup Folder window appears. 

7. Click Next. 

The list of Exigen Universal Process Link components appears. 



Installation and Configuration Guide  Chapter 2: Managing Exigen Universal Process Link Installation 

 

Copyright © 2006, Exigen Properties, Inc. and/or affiliates. All rights reserved.   
Exigen Universal Process Link 5.6 Page 17 of 59 

 
Figure 7: Exigen Universal Process Link components 

Although Application Services and Automatic Queue Server are displayed in the list, they are not 
physically available in the Exigen Universal Process Link installation package. Application Services 
and Automatic Queue Server are included in the components list for the following reasons: 

• It is possible to see which component versions are installed and if they are installed at all. 
• Exigen Installer is able to check if correct component versions are installed. 
• If Application Services and Automatic Queue Server are not installed, the administrator can 

install them during Exigen Universal Process Link installation without launching the Exigen 
Workflow setup application. 

8. In the Install/Upgrade column, select the check box for Exigen Universal Process Link components 
to install. 

9. If Application Services and Automatic Queue Server are not installed or if incorrect versions are 
installed, in the Install/Upgrade column select the check boxes as appropriate. 

Since Application Services and Automatic Queue Server installation packages are not available in 
Exigen Universal Process Link, when Exigen Installer prompts for their installation source, the 
administrator must install the components from the Exigen Workflow installation CD. 
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10. Click Next. 

The Destination Folder window appears. 

 
Figure 8: Destination Folder window 

11. In the Exigen Products Folder box, click Browse and select the directory where Exigen Universal 
Process Link files must be installed. 

12. Click Next. 

The Selected Options window appears. 
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Figure 9: List of selected options 

13. Click Next. 

The Ready to Install the Application window appears. 

 
Figure 10: Ready to Modify the Application window 

14. Click Next. 

Exigen Installer installs Exigen Universal Process Link files. 
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When the installation is finished, a message box appears. 

 
Figure 11: Successful completion message 

15. Click OK. 

Exigen Universal Process Link is installed. 

16. If Automatic Queue Server is installed, start the Automatic Queue Server service. 

Upgrading Exigen Universal Process Link 
To upgrade Exigen Universal Process Link to a newer version, proceed as follows: 

1. In the Exigen Universal Process Link installation package, launch the Setup.exe file located in the 
Windows directory. 

The Exigen Installer Setup window appears. 
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Figure 12: Exigen Installer startup window 

2. Wait while Exigen Installer verifies the list of installed applications. 

The Application Maintenance window appears. 
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Figure 13: Application Maintenance window 

3. Select Modify and click Next. 

The Select Installation Type window appears. 
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Figure 14: Selecting the installation type 

4. Select Upgrade and Upgrade to newer versions only. 
5. Click Next. 

The Destination Folder window appears. 
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Figure 15: Destination Folder window 

6. In the Exigen Products Folder box, click Browse and select the directory where Exigen Universal 
Process Link files must be upgraded. 

7. Click Next. 

The Selected Options window appears. 
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Figure 16: List of selected options 

8. Click Next. 

The Ready to Modify the Application window appears. 

 
Figure 17: Ready to Modify the Application window 

9. Click Next. 

Exigen Installer upgrades Exigen Universal Process Link files. 
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When the installation is finished, a message box appears. 

 
Figure 18: Successful completion message 

10. Click OK. 

Exigen Universal Process Link is upgraded. 

Removing Exigen Universal Process Link 
To remove Exigen Universal Process Link, proceed as follows: 

1. If Automatic Queue Server is installed on the workstation and its service is running, stop the 
Automatic Queue Server service to allow removal of files locked by Automatic Queue Server. 

2. In the Exigen Universal Process Link installation package, launch the Setup.exe file located in the 
Windows directory. 

The Exigen Installer Setup window appears. 
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Figure 19: Exigen Installer startup window 

3. Wait while Exigen Installer verifies the list of installed components. 

The Application Maintenance window appears. 

4. Select Remove and Remove Exigen Solution(s). 
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Figure 20: Removing Exigen Universal Process Link 

5. Click Next. 

The Exigen Installer Uninstall window appears. 
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Figure 21: Confirmation window 

6. Click Next. 

Exigen Installer removes Exigen Universal Process Link. 
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Chapter 3: Configuring Exigen Universal 
Process Link 
To set up Exigen Universal Process Link components, the following procedures must be performed: 

• Configuring the Exigen Universal Process Link Genesys Application 
• Using Exigen Universal Process Link Configuration Console 
• Starting and Stopping UPL Interaction Layer 
• Configuring the Interaction Submitter Job 
• Configuring Genesys Management Layer 

Configuring the Exigen Universal Process Link Genesys 
Application 
To import and configure the Exigen Universal Process Link application in Genesys Configuration Layer, 
proceed as follows: 

1. Open Genesys Configuration Manager.  
2. From the Exigen Universal Process Link installation package, from the Templates directory, import 

the Exigen_UPL template. 
3. From the Exigen_UPL template, create a new application. 
4. Right click the created application and select Properties. 

The Properties window appears. 
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Figure 22: UPL Interaction Layer application properties 

5. If required, in the General tab, change the application name. 
6. Select the Server Info tab. 
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Figure 23: Configuration server settings 

7. In the Host list box, select the host on which the UPL Interaction Layer is running. 
8. In the Communication Port field, enter any unused port. 
9. In the Backup Server list box, select [None]. 
10. In the Redundancy Type list box, select Not Specified. 
11. In other fields, leave default values. 
12. Select the Start Info tab. 
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Figure 24: Configuring starting parameters 

13. In the Working Directory and Command Line fields, enter the following: 

. 

14. Leave the Command Line Arguments field empty. 
15. In other fields, leave default values. 
16. Select the Connections tab. 

The Connections tab is used to define connections to Interaction Servers. 

17. For each server connection to be added, proceed as follows: 
• Click Add.  
• Select the server to connect. 
• Leave the default parameter values. 
• Click OK. 
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Figure 25: Creating connections for UPL Interaction Layer 

18. Select the Options tab. 
19. In the list box, select Log. 
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Figure 26: Configuring UPL Interaction Layer application log settings 

20. Enter log setting values as described in the following table:  
UPL Interaction Layer application log settings 
Name Value 
FileName Log file name. The default log file name is upl.log. When a full path to the 

log file is not specified, the file is created in the system directory.  
Level Log level. It can be set to one of the following values:  

Value Description 
Silent Messages are recorded about important events, such 

as start, stop, and critical errors that result in the failure 
of the system to respond. 

Normal Messages are recorded for effective actions, for 
example, creating connections or objects, or 
performing component tests. All messages listed under 
silent mode are recorded as well. This is the default 
value. 

Trace All actions, including step-by-step results are recorded 
in the log file.  

21. To specify the application timeout value, in the list box select Connection and enter the value in 
seconds for the Timeout parameter. 
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Figure 27: Configuring the application timeout value 

The default value is 10. 

22. Select the Security tab. 



Installation and Configuration Guide  Chapter 3: Configuring Exigen Universal Process Link 

 

Copyright © 2006, Exigen Properties, Inc. and/or affiliates. All rights reserved.   
Exigen Universal Process Link 5.6 Page 37 of 59 

 
Figure 28: Configuring UPL Interaction Layer security 

23. Click Permissions and modify access rights as appropriate. 
24. To save changes, click OK. 
25. Close Genesys Configuration Manager. 

Using Exigen Universal Process Link Configuration 
Console 
For information on Exigen Universal Process Link Configuration Console, see Appendix A: Workflow 
Statistics Architecture. 

The following topics are described in this section: 

• Configuring UPL Interaction Layer 
• Configuring Workflow Statistics 
• Handling Errors 
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Configuring UPL Interaction Layer 
This section describes how to configure UPL Interaction Layer using UPL Configuration Tool. UPL 
Interaction Layer serves as the link between Exigen Workflow and Genesys CIM Platform. 

To configure UPL Interaction Layer, perform the following steps: 

1. To start UPL Configuration Tool, select Start > Programs > Exigen Solution > UPL > UPL 
Configuration Tool. 

The UPL Configuration window appears.  

2. Enter the value as described in the following table: 
UPL Interaction Layer parameters 
Parameter Description 
Host Genesys Configuration Server host name. 
Port Genesys Configuration Server port.  
UPL Application UPL application name in Genesys Configuration Management Environment 

(Genesys CME).  
Login User name for connecting to Genesys Configuration Server. 
Password Password for connecting to Genesys Configuration Server. 
Stat Server Application Stat Server application name in Genesys CME.  

3. Click OK. 
4. Start UPL Interaction Layer as described in Starting and Stopping UPL Interaction Layer. 

Configuring Workflow Statistics 
The Workflow Statistics Configuration window configures database connection settings and 
manages individual metrics. All configuration values in this and other windows are retrieved from or 
updated in Genesys Configuration Server. All values are specific to the instance of Stat Server 
specified in the main window.  

The following topics are described in this section: 

• Configuring Exigen Workflow Database Connection Properties for an Individual Project 
• Configuring Statistical Items 

Configuring Exigen Workflow Database Connection Properties for an Individual 
Project 

Exigen Workflow project databases are the sources of statistical data. Workflow statistics can be 
obtained individually from every project. Workflow statistics are not available for the master database, 
as it contains no project specific run-time data. 

To configure Exigen Workflow database connection properties for an individual project, proceed as 
follows: 

1. Run UPL Configuration Tool. 

The UPL Configuration window appears. 
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2. In the UPL Configuration window, click Workflow Statistics Configuration. 

The Workflow Statistics Configuration window appears.  

 
Figure 29: Workflow Statistics Configuration window 

3. In the Project name list, select the predefined master project. 
4. Enter configuration values as described in the following table: 

Database connection parameters 
Parameter Description 
Project Name Exigen Workflow project name. This parameter is read-only. 
Database driver class JDBC driver class name. 

Database URL Connection URL specific to the JDBC driver. 

Database user Username used to connect to the project database. 
Database password Password used to connect to the project database. 
Pooling frequency (seconds) Time in seconds between statistical value updates to the Stat Server 

cache. 

5. To read all projects from the Exigen Workflow database, click Refresh. 
6. In the Project name list, select the appropriate project. 

In the Workflow Statistics Configuration window, the Statistics used check box appears, and 
the Statistical Items tab is enabled. 
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Figure 30: Configuring the DB Connections tab 

7. In the DB Connections tab, enter database connection parameters as described previously. 
8. To enable or disable gathering of workflow statistics for a project, proceed as follows:  

• To enable configuration settings for a particular project, select the Statistics used check box. 

Select the Statistics used check box only when an appropriate Exigen Workflow project is 
selected in the Project name list.  

• To disable configuration settings for a particular project, clear the Statistics used check box 
after all the statistical items are removed. 

For more information on how to remove the statistical items, see Configuring Statistical Items. 

9. To check the connection to the database, click Test DB Connection. 

The test result is displayed in a message box. If an error is displayed, follow the instructions as 
described in Handling Errors. 

10. To configure advanced settings, click Advanced Settings.  

The Advanced Settings window appears. 

Advanced settings configure properties of the internal database connection pool maintained by 
workflow statistics run-time. Advanced settings must be changed only by experienced system 
administrators familiar with general principles of database connection pools. 
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Figure 31: Configuring the Advanced Settings window 

11. Enter setting values as described in the following table: 
Advanced settings  
Parameter Description 
Minimum pool size Minimum number of connections a pool maintains at any given time. 
Maximum pool size Maximum number of connections a pool maintains at any given time. 

Maximum statements Size of the connection pool prepared statements cache. 
Idle connection test 
period (seconds) 

If this number is greater than 0, the connection pool tests all idle pooled 
connections every number of seconds specified in this field. 

Connection timeout Number of milliseconds a connection pool waits for a connection to be checked in 
or acquired when the pool is exhausted. Zero means wait indefinitely. Setting any 
positive value causes the get connection call to time out and break with an 
exception after the specified number of milliseconds.  

Preferred test query Query executed to test all connections in the pool. The field must contain a valid 
SQL statement. 

12. To execute the SQL statement, click Test Query. 

The test result is displayed in a message box. If an error is displayed, follow the instructions as 
described in Handling Errors. 

13. Click OK. 
14. In the Advanced Settings window, click OK. 



Installation and Configuration Guide  Chapter 3: Configuring Exigen Universal Process Link 

 

Copyright © 2006, Exigen Properties, Inc. and/or affiliates. All rights reserved.   
Exigen Universal Process Link 5.6 Page 42 of 59 

15. To add third party JDBC drivers to the Exigen Universal Process Link Configuration Console class 
path and use them when working with the database, in the DB Connections tab, click Classpath 
Options.  

The Classpath Entries window appears. 

 
Figure 32: Configuring the Classpath Entries window 

16. In the Classpath Entries window, add or modify JDBC drivers as required. 
17. Click OK. 
18. If any JDBC driver was modified or deleted, restart Exigen Universal Process Link Configuration 

Tool. 

Configuring Statistical Items 

To configure statistical items, proceed as follows: 

1. In the UPL Configuration window, click Workflow Statistics Configuration. 
2. Select the Statistical Items tab.  
3. In the Statistical Items tab, add or modify statistical items as required. 

The Statistic Setting window appears. 
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Figure 33: Adding a statistical item 

4. In the Name field, enter the name of the statistical item. 

The statistical item name must be unique for the Stat Server instance. 

5. Create an SQL statement, using the following controls: 
SQL statement creation controls 
Control Description 
Stat objects Types of Genesys objects for which statistical information is obtained. For more 

information on available Genesys objects, see Workflow Statistics and Collections 
of Genesys Objects. 

Metric data type Data type of the value returned by the statistical item. 
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SQL statement creation controls 
Control Description 
Keywords List of predefined SQL commands that can be clicked to automatically add to the 

SQL statement. This control is optional. 
Tables  List of tables in the appropriate Exigen Workflow project. 
Fields List of fields in the selected table. 
Add new keyword Set of controls used to add custom keywords to the Keywords list. 

To add a new SQL command to the Keywords list, in the Add new keyword 

field, enter the SQL command and click . To delete, select from the Keyword 

list and click . 

Depending on the selected values, the generated SQL statement appears in the SQL statement 
field. 

The following table describes buttons available in the SQL Statement Editor box: 

SQL Statement Editor box buttons 
Button Description 
Insert Selected Inserts the combination of the selected keyword, table and field into the current 

cursor position of the SQL statement field. 
Reset Selection Resets the selected values in the Keyboards, Tables, and Fields lists.  

Clear Statement Clears the SQL statement text box. 
Test Query Executes the SQL statement, specified in the SQL statement field. 

It is possible to enter the SQL statement manually in the SQL statement text box. The following 
types of SQL statements are allowed as statistical queries: 

• SELECT 

• CALL  

The SQL statement CALL is used to invoke a stored procedure. 

Other statement types must not be used for statistical queries as they can alter or damage data in 
the database. 

6. To execute the SQL statement, specified in the SQL statement field, click Test Query. 

If the SQL statement contains commands other than SELECT or CALL, to prevent database damage, 
the following warning is displayed:  

 
Figure 34:Test Query warning message  
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Only the first field of the first row in the record set returned by the SQL statement is used in the 
statistic value. If SQL query returns more than one row or field, the following warning message 
appears: 

 
Figure 35: Result window 

If the SQL statement has incorrect syntax, a database specific server error message similar to the 
following appears: 

 
Figure 36: Database query test error window 

If an error is displayed, follow the instructions as described in Handling Errors. 

If everything is correct, the following message appears: 

 
Figure 37: Database test result message 

7. Click OK. 

If the Statistic Settings and Advanced Settings windows are closed by clicking OK and the query 
contains any SQL operators that can potentially damage the database, the following warning 
window appears: 
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Figure 38: Statistic Settings Configuration and Advanced Settings windows warning message 

8. Restart Genesys Stat Server and CCPulse+. 

Handling Errors 
When an error occurs in Exigen Universal Process Link Configuration Console, an appropriate 
message box appears. It contains an error description and, if available, technical information. Detailed 
error information is recorded to the standard error stream. By default, the standard error stream is 
directed to the Windows console, but can be redirected to a file. 

To redirect the error stream to a file, proceed as follows: 

1. In the directory where UPL Interaction Layer is installed, open the UplConfigConsole.bat file. 
2. Replace the following line: 

start javaw -cp %UPL_CC_CP% com.exigen.upl.configuration.ui.impl.Application 

with the following: 

javaw -cp %UPL_CC_CP% com.exigen.upl.configuration.ui.impl.Application 2> 
err.txt 

3. Save the changes. 

Note:  Workflow statistics run-time uses the Stat Server log file to record all errors and exceptions. 

If an error occurs in run-time while calculating statistical values, for example, if Exigen Workflow 
database becomes unavailable, workflow statistics run-time returns -1 as a statistics value. The same 
value is returned even if a string type is used for the statistic. Detailed technical information about run-
time errors is routed to the standard Stat Server log file. 

For information on how to locate the Stat Server log file, see Framework 7.2 Stat Server Deployment 
Guide, Common Log Options. 

Starting and Stopping UPL Interaction Layer 
To start UPL Interaction Layer, perform the following steps: 

1. Select Start > Settings > Control Panel > Administrative Tools > Services. 
2. In the Services window, locate and select the Exigen UPL Interaction Layer service. 
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3. Click Start Service. 

To stop UPL Interaction Layer, perform the following steps: 

1. Select Start > Settings > Control Panel > Administrative Tools > Services. 
2. In the Services window, locate and select the Exigen UPL Interaction Layer service. 
3. Click Stop Service. 

Configuring the Interaction Submitter Job 
This section describes how to configure the Interaction Submitter job and start Automatic Queue 
Server. 

The Interaction Submitter job is an Automatic Queue Server job that uses the following Exigen 
Universal Process Link handlers: 

• Interaction Submitter 
• Interaction Submitter Filter 

To configure the Interaction Submitter job, proceed as follows: 

1. Ensure the Exigen Workflow Queue Server service is started. 
2. Select Start > Programs > Exigen Solution > Exigen Workflow > Queue Server Console. 

The Queue Server Console window appears. 

 
Figure 39: Automatic Queue Server console 

3. Right click Jobs and select New > Queue Server Job. 

The New Queue Server Job window appears. 
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Figure 40: Creating a new job 

4. In the Workflow field, enter the source workflow ID. 
5. In the Node field, enter the source node ID. 
6. In the Mailbox field, enter the source common user ID. 
7. In the Category field, enter the job category. 

The Automatic Queue Server console groups jobs of the same category. This property affects only 
how jobs are displayed in the Automatic Queue Server console. 

8. In the Batch Size field, enter the number of work items processed during a single Automatic Queue 
Server iteration. 

A recommended value is from 1 to 25. 

9. In the Filter ID list box, select VisiFLOW.ProcHandler.QS.UPLSubmitter.Filter. 
10. In the Component ID list box, select VisiFLOW.ProcHandler.QS.UPLSubmitter. 
11. Leave default values in other fields. 
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Figure 41: Configured Interaction Submitter job 

12. Select the Additional Parameters tab. 

The Additional Parameters displays a list of Interaction Submitter handler parameters. 

 
Figure 42: Configuring additional job parameters 

13. For each parameter, perform the following steps: 
• Select a parameter. 
• Press F2. 
• Enter the value as described in the following table: 
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Interaction Submitter parameters 
Parameter Description 
Media Type Value of the enumerator Media Type as defined in the Genesys configuration. 

The default value is workitem. 
Queue Name Name of the target interaction queue in Genesys. 
Interaction Type Value of the enumerator Interaction Type as defined in the Genesys 

configuration. 
The default value is Inbound. 

Interaction Subtype Value of the enumerator Interaction Subtype as defined in the Genesys 
configuration. 
The default value is InboundNew. 

Attached Values List of key and value pairs that are attached to the interaction using the following 
syntax: 

<key 1>=<value 1>,<key 2>=<value 2>,…,<key n>=<value n> 

This parameter is optional. 

Attached Fields List of comma-separated work item field names whose values are attached to the 
interaction. 

The following tables can be used as a source for attached data: 
• BATCHPARCEL 
• DOCUMENT 
• FOLDER 
• SUBFOLDER 
The list format is as follows: 
<table name>$<field name>, <table name>$<field name>, … 

When a table name is omitted, it is assumed that the source table is 
BATCHPARCEL. 
The following is an example of the Attached Fields parameter value:  
IDENTITY, MAILBOX, USER_ID_FROM, BATCHPARCEL$NODE_ID_FROM, 
DOCUMENT$DOC_RSN 

Warning: The PARCEL_USER_ID field must be referenced as MAILBOX and 
the PARCEL_ID field must be referenced as IDENTITY. 
Field values are attached to the interaction according to the following rules: 
• When a parcel contains multiple documents, the value from the first 

document is attached.  
• When a specified table and field name pair does not exist, the Interaction 

Submitter job issues an exception and does not submit the parcel. 
This parameter is optional. 
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Interaction Submitter parameters 
Parameter Description 

Trace Level Level of trace information details. 

The following table describes possible trace level values: 

Level Numeric 
equivalent 

Description 

Fatal 1 Only permanent failures are logged in the 
trace output. 

Error 2 Errors are logged in the trace output. 
Warning 3 Warnings are logged in the trace output. 
Info 4 Trace information is logged in the trace 

output. 
Debug 5 Debug information is logged in the trace 

output. 

All trace messages whose value is less than the specified value are also logged 
in the trace output. 

Interaction Server 
Host 

Host name of the computer on which Interaction Server is running. 

Interaction Server 
Port 

Interaction Server port.  

 

UPL Server Port UPL Interaction Layer port. This port number is also specified when configuring 
UPL Interaction Layer application in Genesys CME.  

UPL Server Host Host name of the computer on which UPL Interaction Layer is running. 

The Interaction Submitter job passes Interaction Server Host and Interaction Server Port to UPL 
Interaction Layer. UPL Interaction Layer uses these parameters to ensure it has a corresponding 
Interaction Server in the connections list of the UPL Interaction Layer application.  

14. In the New Queue Server Job window, click OK. 
15. Close the Automatic Queue Server console. 

The Interaction Submitter job is configured and can be started. For information on starting and stopping 
an Automatic Queue Server job, see Exigen Workflow Administrator’s Guide, Part 2: Business 
Component Reference. 

Configuring Genesys Management Layer 
Exigen Universal Process Link is not directly integrated with Genesys Management Layer but can be 
designated in the Genesys Management Layer as a third party application. For information on setting 
up third party applications in Genesys Management Layer, see Genesys CIM Platform documentation. 
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Chapter 4: Best Practices and 
Recommendations 
This section describes recommendations for solution implementation teams on using workflow 
statistics. Although every effort has been made to align workflow statistics with Genesys built-in 
statistics and make them transparent to use, some subtle differences must be considered when 
implementing workflow statistics. 

The following topics are described in this section: 

• Configuring Statistics in CCPulse+ 
• Workflow Statistics and Collections of Genesys Objects 
• Caching Statistical Values 

Configuring Statistics in CCPulse+ 
Genesys CCPulse+ is a Stat Server client application. It is the standard tool used by system 
administrators to obtain real time and historical metrics on operation of the call or processing center. 
Workflow statistics are available in CCPulse+ as are any other Genesys native statistics. When defining 
workflow statistics in the Exigen Universal Process Link Configuration Console, the administrator 
configures its name and associates it with one or more Genesys object types. This configuration is 
reflected in CCPulse+ and workflow statistics become available only for a configured set of object 
types. 

Workflow statistics are not parameterized, which means that a particular object requesting statistics 
cannot be specified. If the same statistic is requested for agents A1, A2, and A3 then it returns the 
same value for every agent. To create statistics for specific objects, hard coded parameters in the SQL 
statistic query must be used. If it is required to create statistical items for individual agents then it is 
recommended to use the WHERE clause, for example as follows: 

WHERE USER_ID = "A1" 

Genesys Stat Server supports a flexible mechanism to control the frequency of updates of statistical 
values sent back to its clients. Workflow statistics run-time can slightly alter this mechanism, as it 
performs internal caching of statistical values for better database load control. For more information on 
implications on the frequency of updates when using the caching mechanism, see Caching Statistical 
Values. 

The following table describes notification modes supported by Genesys CCPulse+: 
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Notification mode types 
Mode Description 
Time based Instructs Stat Server to recalculate statistics on the frequency displayed in the 

Notification Frequency field. 
Change based Instructs Stat Server to immediately notify CCPulse+ about statistical changes.  

Note: The actual calculation for insensitivity depends on the version of Stat Server 
used. 

No notification Instructs Stat Server to turn off automatic notification for the statistic. 
Reset based Instructs Stat Server to notify CCPulse+ immediately before a statistic is reset to zero. 

Workflow statistics can support aggregation, but only if the statistical query returns aggregated values. 
This can be implemented, for example, by using stored procedures that aggregate data in a database 
table. 

For historical Exigen Workflow reporting, it is recommended to define statistical queries against Exigen 
Workflow audit tables. 

For more information on statistics configuration, see the following documentation: 

• CCPulse+ Help  
• Genesys Reporting Technical Reference Guide 7.2  
• Framework 7.2 Stat Server User's Guide 

Workflow Statistics and Collections of Genesys Objects 
Workflow statistics can be defined for all valid Stat Server object types. Stat Server Genesys objects 
are the following: 

• Agent 
• Place 
• GroupAgents 
• GroupPlaces 
• RegDN 
• RoutePoint 
• Queue 
• GroupQueues 
• Campaign 
• CampaignGroup 
• CallingList 
• CampaignCallingList 

If a workflow statistic is requested for a specific object, data is collected only for that object. When a 
statistic is requested for an object that represents a group, data is collected for the object of the group. 
For example, if statistics are created for an AgentGroup object, data is collected for the AgentGroup 
object, but not for every Agent in the group represented by this object. 
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Caching Statistical Values 
Properties of workflow statistics are defined in client applications, such as CCPulse+. It is possible to 
define time based notifications with frequent updates, such as once every two seconds. Given the 
substantial number of statistics typically configured in production environments, workflow statistics run-
time implements a caching mechanism to limit the number of queries sent to database. The caching 
mechanism ensures that the Exigen Workflow database is not overloaded by excessive queries. 

Caching mechanism of the workflow statistics run-time relies on the following parameters: 

Caching mechanism parameters 
Parameter Description 
Pooling frequency Defines the maximum frequency that the statistical value is recalculated by 

executing the statistic SQL query. For more information on configuring this 
parameter, see Configuring Exigen Workflow Database Connection Properties 
for an Individual Project. 

Notification frequency Defines the frequency Stat Server requests statistical values from workflow 
statistics runtime. For more information on configuring this parameter, see 
Genesys CCPulse+ documentation. 

The caching mechanism selects either pooling frequency or notification frequency as the actual 
database query frequency whichever is greater. If pooling frequency is greater than notification 
frequency, database queries are performed according to the pooling frequency parameter, and the 
CCPulse+ operator can be presented with outdated statistical values. Otherwise, if notification 
frequency is greater than pooling frequency, the frequency of database queries is the same as 
notification frequency. This way caching allows the administrator to balance between database load 
and actuality of statistical values. 

The additional notes on statistical values caching are as follows: 

• Change based and time based statistics are always cached. 
• Reset based statistics are not cached, as their notification frequency depends on time profiles. 
• For non-cached statistics, Exigen Workflow Stat Server Java Extensions (Exigen Workflow SSJE), 

which is an internal name for workflow statistics run-time, executes the SQL statement immediately 
and returns the value to Stat Server. 

• Configuration of interval types does not affect the caching strategy. 
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Appendix A: Workflow Statistics Architecture 
This section describes the structure of workflow statistics. 

The following figure displays the relationship among the involved components. 

 
Figure 43: Exigen Workflow statistical extensions architecture 

The following table defines components that enable workflow statistics run-time to provide workflow 
statistical metrics: 

Component definitions 
Component Definition 
Genesys Stat Server Component supplying statistical information on request about customer interaction 

networks to client applications such as CCPulse+. 
Genesys 
Configuration Server 

Component serving as a central configuration repository for workflow statistics run-
time. It holds configurations for the extensions and individual metrics configured by the 
administrator.  

Stat Server Client Application retrieving statistics provided by Genesys Stat Server. The client application 
defines the applicable set of objects and for each object, it defines the set of metrics to 
retrieve. It can also define retrieval properties, such as frequency of polling, filtering, 
and other activities.  

Exigen Universal 
Process Link 
Configuration 
Console 

Exigen Universal Process Link Configuration Console is a central point of Exigen 
Universal Process Link configuration, including workflow statistics run-time. In regards 
to SSJEs, Exigen Universal Process Link configuration console enables defining and 
associating metrics with certain types of Genesys objects.  

Exigen Workflow 
database 

Storage place for work items and other workflow data. 

For more information on the preceding components, see Exigen Universal Process Link Architecture. 
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Appendix B: Internal Configuration of Workflow 
Statistics 
This section describes the internal structure of workflow statistics configuration.  

Warning: This information must be used for educational purposes only. The configuration values must               
not be modified manually. 

Configuration of workflow statistics is kept in the Genesys Configuration Server database. Configuration   
values are available in the Stat Server configuration part of Genesys Configuration Manager.  

 
Figure 44: Genesys Configuration Manager window 

The Stat Server configuration window resembles the following: 
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Figure 45: Stat Server configuration window 

The main configuration parts are as the following: 

• configuration of SSJEs 
• configuration of workflow statistics run-time 
• configuration of specific statistics 

The following table lists java-extensions section options: 

java-extension section options 
Option Value Description 
WorkflowStat.jar yes Instructs Stat Server to load and use workflow 

statistics run-time from the package 
WorkflowStat.jar. 

The WorkflowStat section defines extension parameters. Some parameters are defined individually for 
each project. They are preceded by the <prj_id> prefix, where <prj_id> is the project ID defined in the 
projects-list option. The following table lists the WorkflowStat section options: 
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WorkflowStat section options 
Option Value Description 
java-extension-jar  WorkflowStat.jar Associates this set of parameters with workflow 

statistics run-time. 
projects-list <comma separated list 

of project IDs> 
Comma separated list of project IDs from the 
S00_PROJECTS table. 

<prj_id>-db-driver-class <JDBC driver class 
name> 

Fully qualified JDBC driver class name, such as the 
following: 
oracle.jdbc.driver.OracleDriver 

<prj_id>-db-driver-url <connection URL> Set of connection parameters specific to the particular 
JDBC driver. 

<prj_id>-db-driver-user <database user name> User name used to connect to the Exigen Workflow 
database. 

<prj_id>-db-driver-password <database user 
password> 

Password used to connect to the Exigen Workflow 
database. This parameter must be encrypted with a 
simple symmetric cipher. 

<prj_id>-polling-frequency <frequency in 
seconds> 

Minimal time interval for database polling to retrieve 
updated metric values. The default value is 60 
seconds. 

<prj_id>-checkout-timeout <timeout in seconds> Time waiting for a connection to be available. The 
default value is 30 seconds. 

<prj_id>-db-min-pool-size <pool size> Minimum number of connections kept in a pool. 
<prj_id>-db-max-pool-size <pool size> Maximum number of connections kept in a pool. If the 

pool size reaches this value, the connection pool waits 
for the number of seconds specified in the <prj_id>-
checkout-timeout option for another connection to be 
returned to the pool. 

<prj_id>-db-max-statements <cache size> Size of the prepared statements cache. 
<prj_id>-db-idle-connection-
test-period 

<test period in 
seconds> 

Frequency of checking idle pool connections for 
validity. 

<prj_id>-db-preffered-test-
query 

<SQL statement> SQL statement used to test a connection for validity. 
This statement must be correct and must not affect 
any data in the Exigen Workflow database. The length 
of the statement is limited to 254 symbols. For the 
master database, the default test statement is the 
following: 
SELECT COUNT(*) FROM S00_PROJECT 
For project databases, the default test statement is the 
following: 
SELECT COUNT(*) FROM <PRJ_ID>_PRJSETUP 

The Stat type alias section configures aliases for particular statistic types. The number of configured 
sections depends on the number of statistics defined in Exigen Universal Process Link Configuration 
Console. The following table lists stat type alias options: 



Installation and Configuration Guide  Appendix B: Internal Configuration of Workflow Statistics 

 

Copyright © 2006, Exigen Properties, Inc. and/or affiliates. All rights reserved.   
Exigen Universal Process Link 5.6 Page 59 of 59 

Stat type alias section  
Option Value Description 
Category JavaCategory Defines the stat type alias as a statistics category 

implemented as SSJE. 
JavaSubCategory WorkflowStat.jar:Workf

lowDoubleStatType or 
WorkflowStat.jar:Workf
lowStringStatType 

Specifies the JAR file containing stat type 
implementation and the main StatType class. Double 
or string StatTypes are automatically selected 
depending of the return type of the metric. 

Objects Any set of standard Genesys 
object types, such as Agent, 
Place, GroupAgents, and 
other 

Defines the set of Genesys object types applicable to 
particular statistics. 

alias-id Any identifier Defines a unique ID for the stat type alias.  
sql<N> Part of SQL statement Defines a set of parameters, such as sql1, sql2, sql3, 

and so on, containing segments of the actual SQL 
statement. All segments are merged together before 
execution. There are no spaces or any other 
characters between segments.  

data-type double or string Defines the type of the metric value.  
project-id <project ID> Defines the project ID for which the metric must be 

retrieved. 
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